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Spreadsheet Concepts 

A spreadsheet is a powerful software application that serves as a digital ledger, allowing 

users to store, organize, manipulate, and analyze data in a grid of rows and columns 

. Modern spreadsheet programs like Microsoft Excel and Google Sheets have replaced 

manual paper and calculator methods for a variety of tasks, from financial accounting to 

data analysis. The following are some of the spreadsheet concepts 

 

 Formulas: These are mathematical calculations that automatically update when 

the data they reference changes. All formulas must begin with an equal sign (=). 

 Functions: These are built-in, predefined formulas that perform specific tasks, 

such as SUM for adding a range of cells, or AVERAGE for calculating the mean. 

 Values: This is the raw data entered into a cell, which can be text, numbers, or 

dates. 

 Recalculation: This is the process where the spreadsheet software automatically 

updates all formula results whenever a value in a referenced cell is changed. 

 What-if analysis: This feature allows you to test different scenarios by changing 

input values to see how they impact the calculated results   

Uses of spreadsheets: 

Financial modeling (forecast, what-if scenarios) Business and financial management 

 Budgeting: Businesses and individuals can track income and expenses to manage their budgets. 

 Financial modeling: You can use spreadsheets to analyze financial performance and create 

forecasts for future growth, costs, or profitability ("what-if" analysis). 

 Accounting: Spreadsheets are used for compiling financial statements like profit-and-loss 

reports, balance sheets, and tax returns. Formulas can be used to perform functions like 

calculating depreciation or a loan's net present value. 

 Inventory management: Businesses can track inventory levels, sales, purchases, and supplier 

information. 

 Sales reporting: Sales managers use spreadsheets to track sales trends, analyze performance 

data, and manage sales staff.  

 

Data organization and analysis 

 Data storage: Spreadsheets provide a simple way to store data in a tabular format, serving as a 

basic database for lists of contacts, customer information, or inventories. 

 Sorting and filtering: Large datasets can be arranged and sorted in different ways (e.g., 

alphabetically or by value). You can also filter data to display only the records that meet 

specific criteria. 

 Visualizing data: Spreadsheets can turn data into visual representations such as charts and 

graphs (e.g., pie charts and bar charts), making trends and patterns easy to understand. 

 Statistical analysis: Built-in statistical functions can be used for calculations such as mean, 

median, and standard deviation to develop more complex data analysis. 



 Pivot tables: This advanced feature allows users to summarize, reorganize, and analyze large 

datasets dynamically by grouping and aggregating data.  

Project and personal management 

 Project management: Spreadsheets can be configured to track project workflows, including 

start and completion dates for specific tasks, resource allocation, and progress. 

 Scheduling and task lists: They are used to create various schedules, from work calendars to 

daily task lists. 

 Personal tracking: Individuals can use spreadsheets to track personal finances, manage an 

RSVP list for an event, or monitor personal health metrics like workouts and weight. 

Education and research 

 Grade tracking: Teachers use spreadsheets to record and calculate student grades and monitor 

academic progress over time. 

 Scientific research: Scientists and researchers use spreadsheets to compile and analyze results 

from experiments and to perform mathematical calculations. 

2. Elements of Spreadsheet Window 

Here are the parts you see when you open a spreadsheet application (e.g. Excel, Sheets): 

Core spreadsheet elements 

 Workbook: The entire spreadsheet file, which can contain one or more individual 

worksheets. 

 Worksheet: A single page within a workbook, consisting of a grid of cells. 

 Cells: The basic building blocks of a worksheet. A cell is the intersection of a row and a 

column where you enter data. 

 Rows: The horizontal divisions of a worksheet, identified by numbers (e.g., 1, 2, 3). 

 Columns: The vertical divisions of a worksheet, identified by letters (e.g., A, B, C). 

 Cell Address/Reference: The unique name given to a cell, which is based on its column 

letter and row number (e.g., cell A1 or B3). 

 Active Cell: The currently selected cell, indicated by a prominent border. 

 Range: A group of selected cells. For example, A1:A5 refers to a range of five cells. 



 Sheet Tabs: Located at the bottom of the window, these tabs allow you to switch 

between the different worksheets in a workbook.  

Interface elements 

 Title Bar: Displays the name of the spreadsheet file. 

 Ribbon/Toolbar: The area at the top of the window that contains various tabs (e.g., File, 

Home, Insert). When you click a tab, the ribbon displays different groups of commands 

and options. 

 Name Box: Located on the left side of the formula bar, this box shows the address of the 

active cell or range. You can also use it to quickly navigate to a specific cell. 

 Formula Bar: An input line that displays the content of the active cell. You can use it to 

enter or edit data, text, or formulas. 

 Status Bar: Located at the bottom of the window, this bar displays information about 

the current state of the spreadsheet. For instance, it can show the sum or average of 

selected cells. 

 Scroll Bars: These allow you to move up, down, or sideways through the worksheet. 

 Zoom Control: A slider that lets you zoom in or out of the worksheet for a closer or 

wider view. 

 



 

 

  



 

3. Cell Referencing 

When you use formulas to compute things (for example, add two cells), you refer to 

specific cells. There are three kinds of referencing. Which one you use depends on 

whether you want your formula to remain the same when copied, or adjust to new 

positions. 

Type Definition Syntax / Example 
How behaves when 

copied 

Relative 

referencing 

Cell references that 

change when the 

formula is copied to 

another cell (they 

adjust based on 

relative position) 

Example: in cell C1 you type 

=A1 + B1. If you copy from 

C1 to C2, the formula 

becomes =A2 + B2 

automatically. 

Useful when doing 

repetitive calculations 

down rows or across 

columns. 

Absolute 

referencing 

References that stay 

fixed even when 

formula is copied 

elsewhere 

Use $ signs. Example: $A$1 

always refers to cell A1 no 

matter where you copy. If 

formula is =$A$1 * B1, and 

you copy that to C2, it 

becomes =$A$1 * C2 (the 

$A$1 stays the same). 

Useful when you 

have a constant or 

fixed value (e.g. tax 

rate, interest rate, a 

single cell reference) 

that should not shift. 

Mixed 

referencing 

A mix: either row 

fixed or column 

fixed, but not both 

Two possibilities: $A1 

(column A fixed, row 

relative), or A$1 (row 1 fixed, 

column relative). Example: 

formula =A$1 * B2. If copied 

Helps in more 

flexible templates 

where you want one 

dimension fixed, the 

other relative. 



Type Definition Syntax / Example 
How behaves when 

copied 

across or down, the part with 

$ behaves absolutely. 

 

Example to illustrate: 

Suppose we have a spreadsheet for student marks. In row 1 we have headings: 

A1=“Name”, B1=“Math”, C1=“Science”, D1=“Total”. Suppose we want to compute 

Total = Math + Science. 

 If in D2 we put =B2 + C2, that’s relative referencing. If we copy that formula 

down to D3, it will become =B3 + C3, etc. 

 If we have one cell, say F1, which contains a bonus mark (say 5), and we want to 

add that bonus to each total, the formula might be =B2 + C2 + $F$1. When copied 

down, F1 remains the same. 

 If for some reason we want to always add the mark from column B but keep row 

fixed, maybe something like =B$1 + C2 etc., though that is less common. 

 

4. Spreadsheet Editing Features 

To build and maintain useful workbooks, we need to know editing features. These let us 

change structure (rows/columns), correct errors, enhance presentation, etc. 

4.1 Worksheet Editing 

These are operations you do to a worksheet (whole sheet level) or within it: 

 Renaming a worksheet (e.g. from “Sheet1” to “Sales 2025”) 

 Adding new worksheets 



 Deleting worksheets 

 Moving or copying worksheets within the workbook 

 Formatting worksheets (background, gridlines, headings) 

 Setting view options (e.g. freeze panes, hide/show headers, adjust zoom) 

Example: Freeze the top row so that headings remain visible when you scroll down. 

4.2 Inserting / Deleting Rows & Columns 

Because layouts often change, you need to insert or delete rows/columns. 

Operation 
How done / what 

happens 
Example 

Insert Row(s) 

Select a row (or more), 

right-click → Insert (or 

via menu). The existing 

rows shift down. 

Suppose you forgot to include a “Middle 

Name” column between First Name 

(column B) and Last Name (column C). 

You insert a new column at C, shifting 

old C onward to D, etc. 

Insert 

Column(s) 

Similar: select column, 

insert, existing columns 

move right. 

As above. 

Delete Row(s) or 

Column(s) 

Remove that row/column; 

everything shifts up (for 

rows) or left (for 

columns). 

If column D (say “Science”) is redundant, 

delete it and data in that column 

disappears, columns to the right shift. 

Adjusting 

widths/heights 

You can widen columns, 

heighten rows to fit 

content (e.g., wrap text). 

If a cell’s content is longer than column 

width, you can auto-fit the column width. 

 



4.3 Other Editing of Cells 

 Editing contents: double-click or use formula bar to change content 

 Copy / Cut / Paste cells or ranges 

 Filling series: dragging the fill handle (corner of selected cell) to auto-extend 

numbers or text patterns 

 Formatting: font, color, borders, alignment, number formats (currency, date, 

percentage) 

 Clearing / deleting content (but maybe leaving formats) 

 

5. Putting It All Together: Example of Creating a Simple Workbook 

Here’s a step-by-step example to make this concrete. 

Scenario 

You want to track monthly expenses for a year. You’ll create a workbook with: 

 One worksheet called "Expenses2025" 

 Columns: Month, Rent, Utilities, Food, Total 

 You’ll input expense data for each month 

 Compute Total per month, and also compute yearly-totals 

Steps 

1. Open spreadsheet software → create new workbook. 

2. Rename the first worksheet to “Expenses2025”. 

3. In row 1, enter headings: 

o A1 = Month 

o B1 = Rent 

o C1 = Utilities 

o D1 = Food 



o E1 = Total 

4. In column A, enter the months: Jan, Feb, Mar, … up to Dec in A2:A13. 

5. In B2:D13, enter the amounts for Rent, Utilities, Food for each month. 

6. In E2, enter formula =B2 + C2 + D2 (relative referencing). Copy that down to 

E3:E13. Now each month's total is computed. 

7. At E14, to compute yearly totals, in B14 put =SUM(B2:B13), similarly for 

columns C, D, E. 

8. Suppose you have a special fixed surcharge in cell G1 (say “Annual Insurance”) 

you want to always add to the yearly total. If you want to include it in yearly total, 

you could write, in E14, =SUM(E2:E13) + $G$1. The $G$1 ensures when 

copying or moving formulas, that cell stays fixed. 

9. Format the headings: bold, maybe shade the header row. Adjust column widths so 

that text fits. Format numbers as currency. 

10. Save the workbook (e.g. “YearlyExpenses2025.xlsx”). 

Example of Relative vs Absolute vs Mixed 

 If you copy the formula in E2 (=B2 + C2 + D2) to E3, relative referencing ensures 

it becomes =B3 + C3 + D3. 

 If you had a cell H1 with fixed tax rate (say 5%) and in each total you wanted to 

compute tax = Total * H1, you might write a formula like =E2 * $H$1. Here 

$H$1 is absolute. 

 If you want column fixed but row relative, or vice versa, you might use =$H$1 or 

=H$1 depending whether you transpose or move. 

 

6. Visual Example with Parts Labelled 

In the images above you can see: 

 The column headers labelled by letters (A, B, C…) across top. 

 Row headers labelled by numbers (1, 2, 3…) down left. 



 One cell highlighted (active cell), e.g. C5 (where column C and row 5 cross). 

 Grid of cells making up the worksheet. 

 Multiple worksheets possibly shown as tabs at bottom. 

2.2.2 Spreadsheet Editing Features 

Spreadsheet editing refers to changing the structure or layout of a worksheet/workbook, 

modifying rows, columns, worksheets, etc. 

2.2.2.1 Worksheet Editing 

This is a broad term meaning making changes in an individual “sheet” within the 

workbook. Includes inserting/removing rows or columns, adjusting sizes, working with 

worksheets (add, rename, move, delete). Essentially, anything that modifies how the 

sheet is structured. 

 

2.2.2.2 Inserting Rows / Columns 

What it means: 

Adding blank rows or columns to a worksheet so you can insert new data without 

overwriting existing data. 

How to do it (typical methods): 

Method Steps 

Right-click 

menu 

Select a row number (for inserting a row) or column letter (for 

column). Right-click → Insert. If inserting a row: “Insert Row Above” 

(or “Insert Entire Row” depending on software); for column: “Insert 

Column Left/Right” or “Entire Column.” 



Method Steps 

Menu / 

Ribbon 

commands 

Go to Home or Insert tab → locate Insert → choose Insert Sheet Rows 

or Insert Sheet Columns. 

Keyboard 

shortcuts 

Many programs support e.g. Ctrl + Shift + + (plus key) after selecting 

row/column. Or Alt + I + R / Alt + I + C in older Excel versions for 

Insert Row / Column. 

 

Examples: 

 Suppose you have a table of student names in A2:A10, scores in B2:B10, and you 

realize you missed a student. You want to insert a new row between row 5 and 6. 

You select row 6, then Insert → Entire Row. Everything below shifts down, so no 

data is lost, just moved. 

 Or you have quarterly data in columns B, C, D (Q1, Q2, Q3), and you want to add 

Q2.5 in between Q2 and Q3. You select column D, Insert Entire Column → new 

column appears before D. 

 

2.2.2.3 Removing Rows / Columns 

What it means: 

Deleting empty or unwanted rows or columns to clean up or restructure. 

How to do it: 

 Select the row(s) or column(s) you want to remove. 

 Right-click → Delete → Entire Row or Entire Column. 

 Or via Ribbon: Home → Delete → Delete Sheet Rows / Delete Sheet Columns. 



 Keyboard shortcuts vary: e.g. Ctrl + - (minus key) in Excel when rows/columns 

selected. 

Considerations: 

 Deleting rows/columns shifts adjacent data up (for rows) or to the left (for 

columns). 

 If formulas refer to cells in deleted rows/columns, those formulas may break or 

result in errors (#REF! etc). 

 Always check dependencies before deleting. 

 

2.2.2.4 Adjusting Row Heights and Column Widths 

Row height is how tall a row is; column width is how wide a column is. Adjusting 

them helps with readability, fitting data, making headings visible, etc. 

How to adjust: 

 Manually: Move cursor to boundary between row numbers (left side) for rows or 

between column letters (top) for columns, then click and drag until desired size. 

 Auto-fit / Auto-adjust: Double-click boundary to auto-size to fit the content (i.e. 

row height fits the tallest cell; column width fits the widest cell in that column). 

 Via dialogs / format menu: You can specify explicit sizes (e.g. width = 15 units, 

height = 20 points) in a formatting dialog. 

Examples: 

 You have a header row with text that wraps or is long; you increase the row height 

so the text becomes visible without cutting off. 

 For a column with numbers (e.g. currency) that are large, you widen the column 

so all digits show; otherwise they may display as “###” or truncated. 

 



2.2.2.5 Inserting Worksheets 

Worksheets (or “sheets”) are individual tabs in a workbook. Inserting a worksheet 

means adding a new blank sheet. 

How: 

 Click the “+” icon (usually next to existing tabs) to add a new worksheet. 

 Or via menu: Insert → Worksheet (or New Sheet). 

 Shortcut keys: e.g. Shift + F11 in Excel. 

Why use it: 

 To organise different but related data (e.g. one sheet per month, one for 

summary). 

 To separate raw data and calculations. 

 To keep working copies or versions. 

 

2.2.2.6 Renaming Worksheets 

Changing the name of a sheet helps identify what’s in it. 

How: 

 Double-click the sheet tab; type new name. 

 Right click sheet tab → Rename. 

 Via menu: Format or Sheet options → Rename. 

Tips: 

 Use meaningful names (“Budget_2025”, “Sales_Q1”) rather than generic ones. 

 Do not include illegal characters (depends on software: e.g. : \ / ? * etc might be 

disallowed). 

 Keep names short but descriptive. 



 

2.2.2.7 Move or Copy Worksheets 

Important when reorganising workbook or reusing sheets. 

Move: 

 Drag the sheet tab to a new position among tabs. 

 Or via right click → “Move or Tab” to position before/after another sheet. 

Copy: 

 Right click on tab → Move or Copy… → select “Create a copy” then choose 

where to put it (in the same workbook or another). 

 Or use “Duplicate sheet” if available. 

Examples: 

 You have a monthly sales sheet for “January” and want same layout for 

“February” → copy the sheet, rename to “February”, then enter data. 

 For backup, copy a sheet before making large changes. 

 

2.2.2.8 Deleting Worksheets 

When a sheet is no longer needed. 

How: 

 Right click the sheet tab → Delete. 

 Menu: Sheet → Delete. 

 Warning prompts usually appear (“Do you want to permanently delete this 

sheet?”) because data will be lost. 

Precautions: 



 Ensure sheet isn’t referenced by formulas elsewhere. 

 Back up if it had unique data. 

 Delete only when sure. 

 

2.2.3 Data Manipulation in Spreadsheets 

Dealing with data entry, types of data, making sure data is handled properly. 

2.2.3.1 Data Entry 

Entering values into cells. 

 Click a cell → type → press Enter or Tab to move to next cell. 

 Can also copy & paste. 

 Use fill features (drag handle) to repeat or auto-increment data (dates, numbers, 

sequences). 

Good practices: 

 Use consistent format (dates, numbers). 

 Avoid leaving blank rows or columns unnecessarily. 

 Label your columns and rows clearly. 

2.2.3.2 Types of Data 

Cells can hold different kinds of data: 

Type Description Examples 

Text (string) 
Anything non-numeric; letters, words, 

combination 

Names, addresses, product 

descriptions 

Number Numeric values; used in calculations 100, 45.72, -3, 0.005 



Type Description Examples 

Date / Time Special types interpreted by software 
23-Sep-2025, 14:30, 

2025-09-23 

Logical 

(Boolean) 
TRUE / FALSE (yes/no) values 

=A1 > B1 returns TRUE or 

FALSE 

Currency / 

Financial 
Numbers with currency formatting $100.00, KES 500 

Percentage Number expressed as per hundred 25%, 0.75 

Formulas Expressions to compute values 
=A1 + B2, 

=SUM(A1:A10) 

Blank / Empty 

cells 

No data; often significant in calculations 

(e.g. skipping, adopting default) 
 

 

2.3 Formulas and Functions 

Formulas let you perform calculations; functions are built-in formulas. 

2.3.1.1 Formulas and Functions Syntax 

General syntax: 

 Formulas typically begin with equals sign =. 

 Then you may have cell references, operators, function names, parentheses. 

 Example: =A2 + B2 * C2 

 Function syntax: =FUNCTION_NAME(argument1, argument2, ...) 

Operator precedence: 

 Multiplication / division before addition / subtraction, etc. 



 Use parentheses () to force certain order: e.g. =(A2 + B2) * C2. 

2.3.1.2 Arithmetic Functions 

Use for numerical calculations. 

Common arithmetic functions include: 

 SUM(range) — adds all numbers in a range. Example: =SUM(A1:A10) 

 AVERAGE(range) — calculates mean. 

 MIN(range), MAX(range) — smallest or largest. 

 ROUND(number, num_digits) — round to specific decimal places. 

 Basic operators: +, -, *, /, ^ (power). 

Example: 

Suppose you have sales in B2:B10, expenses in C2:C10: 

 Profit per row: =B2 - C2 

 Total profit: =SUM(B2:B10) - SUM(C2:C10) 

 Average sales: =AVERAGE(B2:B10) 

2.3.1.3 Logical Functions 

Used to test conditions; return TRUE / FALSE or other values. 

 IF(condition, value_if_true, value_if_false) — e.g. =IF(A2>=50, "Pass", "Fail") 

 AND(condition1, condition2, ...) — all must be true. 

 OR(condition1, condition2, …) — at least one true. 

 NOT(condition) — inverts. 

 Combined: e.g. =IF(AND(A2>=50, B2>=50), "Good", "Check") 

2.3.1.4 Lookup Functions 

For finding stuff in a table or matching values.  



 VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup]) — 

vertical lookup. 

 HLOOKUP(...) — horizontal version. 

 INDEX & MATCH — more flexible and powerful. 

 LOOKUP(...) — older, less specific. 

 In some spreadsheets: XLOOKUP or VLOOKUP with better functionality. 

Example: 

You have a table of product codes in A2:A20, and prices in B2:B20. You have a code in 

D2 and want price: =VLOOKUP(D2, A2:B20, 2, FALSE). 

Or using MATCH/INDEX: 

=INDEX(B2:B20, MATCH(D2, A2:A20, 0)) 

 

2.3.2 Spreadsheet Formatting 

Making the data look good, readable, informative. 

2.3.2.1 Font Styles 

Changing the look of text: 

 Typeface (Arial, Times New Roman, Calibri, etc.). 

 Font size. 

 Bold, Italic, Underline. 

 Color of font. 

 Effects (strikethrough, superscript/subscript). 

Use styles to highlight headers, totals, etc. 



2.3.2.2 Alignment 

How contents are positioned in cells. 

 Horizontal alignment: Left, Center, Right. 

 Vertical alignment: Top, Middle, Bottom. 

 Also wrap text (if content longer than cell width). 

 Merge cells (for headings that span multiple columns). 

 Orientation (rotate text, angled text) sometimes used. 

2.3.2.3 Borders and Shading 

 Borders: to draw grid lines or separate sections. Can apply different border styles 

(thin, thick, and dashed). 

 Shading / Fill colour: background colour of cells to distinguish header rows, 

totals, alternate rows (banded shading) for readability. 

2.3.2.4 Header and Footer 

When printing, you often want consistent header/footer. 

 Header: appears at top of each printed page (e.g. report title, date, page number). 

 Footer: bottom of pages (page numbers, confidentiality notice, etc.). 

 Set via Page Layout or Print Setup → Header/Footer. 

 

2.4 Charts Generation & Printing 

Charts help visualise data. Also good printing behaviour. 

 

2.4.1 Types of Charts 

Charts are graphic representations. Common types: 



 Column chart / Bar chart — compare values across categories. 

 Line chart — show trends over time. 

 Pie chart — show parts of a whole. 

 Area chart — cumulative totals. 

 Scatter plot — relationships between two numeric variables. 

 Combo charts — combining e.g. line + column. 

 

2.4.1.2 Insert Charts 

Step-by-Step Guide 

1. Select Your Data: Highlight the cells containing the data you want to visualize, including 

column headers and row labels. 

2. Go to the Insert Tab: Click on the Insert tab located in the Excel ribbon. 

3. Choose a Chart Type: 

o Recommended Charts: Click the Recommended Charts button in the Charts group to 

have Excel suggest suitable chart types based on your selected data. 

o Specific Chart Type: Alternatively, click one of the chart icons (like Column, Line, or 

Bar) in the Charts group to see a list of available subtypes. 

4. Select a Chart Subtype: Choose a specific chart subtype that best represents your data from the 

options that appear. 

5. Insert the Chart: Click OK to insert the selected chart into your worksheet 

 

2.4.1.3 Labelling and Editing Charts 

Once chart is inserted: 

 Add/modify chart title. 

 Add axis titles (X-axis, Y-axis). 

 Adjust legends. 

 Data labels (showing actual values on bars or pie slices). 

 Format colours, fonts, line styles. 

 Resize chart, reposition. 

Example: A bar chart of sales by region; you might label the X axis “Region”, Y axis 

“Sales in KES”, title “Sales by Region Q3”. 



 

2.4.1.4 Workbook Printing 

Getting the workbook (or parts of it) onto paper or PDF. 

 Selecting which sheets/pages to print. 

 Print preview to see how pages will look. 

 Scaling (fit all columns on one page, adjust margins). 

 Headers/footers in print. 

 

2.4.1.5 Print Setup 

Settings before printing: 

 Page orientation: Portrait vs Landscape. 

 Paper size (Letter, A4, etc.). 

 Margins. 

 Scaling (e.g. “Fit sheet on one page”, “Fit all columns on one page”). 

 Print titles (repeat header rows or columns on every page). 

 Gridlines (choose whether to print cell gridlines). 

 

2.4.1.6 Printing 

The final step: 

 Use Print (File → Print) or Ctrl + P. 

 Choose printer or export (PDF). 

 Confirm what’s being printed (active sheet, entire workbook, selection). 

 Check page breaks and final layout. 
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